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Getting Started 
Importance and Benefits of UKG (Kronos) 

 
Purpose 
It is important that your employees are compensated accurately. To make this happen, you need to manage 
employees worked and non-worked hours, as well as attendance issues, in an efficient and timely manner. 
The application supports your ability to perform these tasks so that the data sent to payroll is accurate. 

The following are the benefits that UKG provides to the City of Houston: 
 Automates and simplifies your timekeeping and scheduling tasks 
 Saves both time and money 
 Assists with scheduling standardization and policy enforcement 
 Improves time and attendance tracking 
 Enables better end-to-end timekeeping 
 Automates the time-off request process 

 

Payroll Process 
The application automates the payroll process, ensuring that the payroll is processed accurately and on time. 
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Roles and Responsibilities 
 

Purpose 
Each employee and timekeeper/supervisor have responsibilities that are important in the payroll process. 
Each person’s role determines his or her responsibilities and the tasks that he or she performs in the 
application. 

 
 Common Employee Tasks  
Daily - employees perform the following tasks: 

 Clock in and out according to their scheduled shifts from an approved device per department/management. 

 Approve their timecard (optional), which allows the employee to review their time before  

 supervisor/manager approval. 

 Submit requests for time off 
 

 Common Timekeeper/Supervisor Tasks  
Daily - timekeepers/supervisors perform the following tasks: 

 Review employees’ time using a Genie 

 Manage timecard edits and schedules 

Pay period end - timekeepers/supervisors perform the following tasks: 

 Perform final review and approve timecards (MANDATORY) 
 

 Common Payroll Department Tasks  
Pay period or as needed - Payroll will perform the following tasks: 

 Perform a final review of employee timecards 

 Sign off timecards 

 Extract time data from the application to send to the payroll system 

 Perform historical edits 
 
 

Note:  If you are not able to view your Direct Reports in Kronos, contact your Departmental HR Representative.  
The Departmental HR Representative will need to perform a position to position transfer to have your employees 
report directly to the approved Manager/Supervisor.
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Logging On 
Purpose 
The UKG log on page provides access to all the features for performing your time and attendance tasks. 

 
Example 
You, as the timekeeper/supervisor, log on to the UKG application at least once a day to review and work with 
your employees’ timecards and scheduling data. 

 
 

 
 

Steps 

1  Type your Username and Password in their designated fields. 

2  Click Log On button or press Enter key on the keyboard. 
 
 

Note (only for HAS and HPD) 
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Logging Off of UKG 
Purpose 
The application provides security to prevent other people from accessing your information and helps keep your 
employees’ information confidential. 

 
Regaining access after the inactivity timeout 
Inactivity timeout protects sensitive information in the application. If the application does not detect activity 
within a specific amount of time, it automatically logs you off. To regain access to the application, you must re- 
enter your password in the inactivity timeout screen. When you regain access, the application restores the last 
page you were viewing. 

 

 
 

Upon completion of your tasks, you must Sign Out of the application to ensure that your employees’ 
information is kept confidential. 

 
 

 
 
 

Note 
Users will log on using their City of Houston network user name and password. 

The inactivity timeout screen appears if there is no activity in UKG for 30 minutes. 

Caution 

If you do not log in after an inactivity timeout, you will lose all unsaved edits.  
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Navigating UKG Page 
Purpose 
The page displayed will appear on the Manager’s Workspace only. You’ll see your employees Punch 
Exceptions in your Primary Widget Area; Default Request Manager and COH All Quick Links in your 
Secondary Widget Area; All other Widgets will be located in your Related Items Pane. 

 
A Genie is a pre-defined view that summarizes and organizes information according to common tasks you 
perform on a regular basis. The name of the Genie reflects a common task, such as Reconcile Timecard. 

 

 
 
 

Using the tools within the workspace 
 

QuickFind is located at the top left side of the workspace and allow you to access information specific to one or 
more employees.  

 
The Show field allows you to display a group of employees. The default setting for the Show field when you log 
on is All Home, which displays all employees that report to you. You can use the Show field to further refine 
your selection to include employees in a specific group, such as only those employees that are working in a 
particular area, or on a particular shift. 

 
The Time Period field allows you to determine the timeframe you want to view, such as the Current Pay Period, 
or a particular timeframe in the past. The time period you select determines what you will see on that page. 

 
The Menu Bar contains tasks that you can perform on the page. Each Menu Bar is specific to the page you are 
currently viewing. 
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Steps 
1  In the workspace area, highlight the employees for whom you need to access data. 

2  Verify the Time Period you want to work in. 

3  Use the Go To menu to access the task you want to perform. 

 

Tip 
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 Using Online Help 
 

Purpose 
The application contains a context-sensitive online Help system to help you 
perform timekeeping tasks. 
 
 
 
 
 
 
 
 
 
 
    

 
 

Steps 
1  In the Related Items pane, click All Quick Links. 

2 
Go to Resource Links > Help 

3 This link displays a Help topic specific to where you are in the application. 
 

 

 
 

Component Description 

Contents tab Collection of topics. 

Index tab Alphabetical directory of all Help topics. 
 
Search tab 

Tool for entering a specific word or phrase; topics appear with 
percent rankings that identify their relevance. 

View/Hide Helper Tabs Displays or hides related topics and terms. 

Show Full Screen/Show 
Headers 

Hides or displays the banner within the Help topic page. 

 
Topics List Available topics to select. If you are on the Search tab, the rank 

number identifies the relevancy of the topic to the entered search data. 
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Refreshing and Saving Data 
Purpose 
When you add and modify schedule data, the application displays your edits but does not save them 
automatically. You must tell the application to save the data. Prior to saving your data, you can cancel your 
edits if necessary. 

 
Visual indicators 
When you edit a schedule, the Save icon turns orange to let you 
know that your data is not yet saved. After you save the data, the 
Save icon is greyed out. 

 
Canceling edits 
The application does not save your edits until you tell it to do so. Until that time, you can remove or cancel your 
edits using the Refresh icon. When you click the Refresh icon, the application will display a warning message 
making you aware of unsaved changes. If you continue without saving the edits, the application re-displays the 
most recently saved information, overwriting your unsaved edits. 

 

 
Saving edits 
When you are satisfied with your edits, you must save them. If you close the employee’s schedule before you 
save the edits, they are not saved. The application will warn you of unsaved changes. 

Steps 

1 Perform your edits to a schedule. Note the visual indicator with the Save icon that indicates unsaved 
data. 

2 Click Save. 

3 Review the employee’s schedule to ensure that the Save icon is greyed out, validating that your 
information was saved. 

Steps 

1  
Perform your edits to a schedule. Note the visual indicator with the Save icon that indicates unsaved 
data. 

2  
Click Refresh and review the Warning pop-up window. 

3 To cancel edits, click Yes. If you do not want to cancel and want to close the Warning window, click 
No. 
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Scheduling Employees 
Schedules Overview 
Purpose 
UKG includes the Schedule Editor where you schedule worked and non-worked hours. All employees must have a 
schedule in UKG.  An Exempt employee timecard verifies time worked based on the schedule listed in UKG. A Non-
exempt employee work schedule displays the start and stop time of a shift. (Helps display issues outside of their 
schedule for example missed punch, late/early in and late/early out on the Timecard.) 

Using the Schedule Editor, you can: 

 Add, edit, and delete shifts 
 Add pay codes for worked or non-worked hours 
 Schedule labor transfers 

 
Navigating to the Schedules 
After selecting the employee(s) you whose schedule want to edit, use the following steps to navigate to the 
Schedules widget: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
Steps 

1 Click the Go To menu and select Schedules. 

2 Select the Time Period and Show (e.g. Current Schedule Period, All Home). 
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 Areas Description 

A. Quick Actions Click to access icons that allow you to perform the most common 
scheduling tasks quickly and easily. 

B. View/Visibility Select how you want to view the schedule and which schedule elements 
you see. 

C. Tabular/Gantt 
View 

Toggle between tabular and graphical views of the schedule. Edits can be 
performed from either view. 

D. Context Set the time period and group of employees that you want to work with. 

E. Indicators Displays schedule totals. 

F. Orange Circle  Indicates the current day and week. 
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Assigning Exempt Employees to a Schedule Group  
Purpose 
A schedule group is selected in UKG for “Exempt employees” to match their schedule group in SAP. The 
Schedule Group is selected based on the days worked in the pay period and the number of hours per day. A 
Schedule Group for an exempt employee must be effective from the first day of a pay period. Do not change 
the Schedule Group for an exempt employee effective in the midst of a pay period. 

 
 
 
 
 
 

Example 
An exempt employee works 8 hours per day Monday thru Friday with Saturday and Sunday off. Add the 
employee to the “00 Open Work Mon- Fri 8-Day +SSD” Schedule Group. 

 

                      
 
 

Steps 

1 Click View. 

2 Select By Schedule Group. 

3 Select the employee and right-click on his name. Select Add to Group. 

           Note 
           You can add more than one employee to a group by selecting all the employees and  
            right-clicking on one of the employee names. Select Add to Group. Any information 
            entered in the Add to Group window will apply to all employees selected. 

           Note 
           The start and end times will be added via the Shift Template separately from the Schedule 
            Group. 
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Steps 

4 From the Schedule Group  
 

 
 

 

 drop-down list, select the name 
of the schedule group to which 
you want to assign the exempt 
employee(s). 
Only select a “00 Open” 
Schedule Group. 

 

 
 

5 In the Start Date drop-down 
list, select the first day of the 
pay period for the effective 
date. 

 
 

6 In the End Date drop-down list, 
select the last date that the 
schedule group assignment 
is effective. For the 
assignment to be in effect 
with no end date, select 
Forever. 

 

7 Leave the box checked for 
“Remove employees from 
other schedule inheritance 
groups for selected date 
range.” 

 

 

8  
 

Click Apply. 

 

 

9  
 
 

Click Save. 
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Removing Employees from a Schedule Group                   
Purpose 
Sometimes an employee is incorrectly assigned to a schedule group or needs to move from one schedule 
group to another. In either case, you would need to remove the employee from the schedule group. 

 
Example 
You assigned an employee to the 0700-1630 30 DAY EX Mon-Thu 9 Fri 4 +9SSF4D schedule group in error. 
Remove the employee from the erroneous group. 

                      
 

Steps 

1 Click View. 

2 Select By Schedule Group. 

3 Select the employee and right-click on his name. Select Remove from Group. 

 
 

 
4 From the Schedule Group drop- down list, select the name of the schedule group from which you 

want to remove the employee from. 

5  
From the Start Date drop-down list, specify the effective date to remove the employee from the 
schedule group. 

6  
From the End Date drop-down list, specify the date the removal is no longer in effect. To remove 
the employee from the schedule group indefinitely, select Forever. 
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7 Click Apply and then click Save. 

8 
Click the Refresh icon. 

9  
Confirm that the employee(s) were removed from the schedule group. 

 
 
 

 

 

Tip 
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Creating a Schedule Pattern 
(Making a schedule change for an employee with a current or future date) 

Purpose 
Create a schedule pattern manually and apply it to one or more employees. You would need to create it manually 
again. DO NOT edit the current schedule, always add a new one. 

 
 

Steps 

1 
In the Schedules widget, select the specific time period from the Time Period drop-down list. The default is 
Current Schedule Period. 

2 
Select the employee(s) to change their schedule using a new pattern. To select multiple employees, hold 
the Ctrl key and click each employee’s name. 

3 

 
Right-click the employee’s name and select Schedule Pattern.  

 

4 

 
Always select Add Pattern, then OK 
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Steps  

5  
Select the Anchor Date and 
the Start Date to establish the 
employee(s) starting dates 
they will be working the 
schedule pattern. 

 

 
 
 
 
 

6 
By default, the Forever button 
will be selected. If it is a 
temporary schedule, select an 
End Date. The temporary 
schedule will expire on the 
date specified and the 
previous schedule will begin. 

7 
To replace all other assigned 
schedule patterns with the new 
schedule pattern, select the 
Override Other Patterns 
checkbox. Check this box if you 
are making a schedule change 
for an employee with a current 
of future date.  

8 
Click the cell of each day that 
applies to the schedule pattern. 
To select multiple days, hold 
the Ctrl key and single-click the 
appropriate cells. 

9 
Click Add Shift, located on the 
left side. Type the Start Time, 
End Time, and select the 
correct Work Rule Transfer. 

10 
Verify your shift times and work 
rule then Click Apply. 
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11 
Verify your new 
schedule, click Apply. 

 
12  

 
 

Verify your pattern and  
Click OK. 

 

 
 
 
 
 
 
 
 

13  

Click Save. 

 

 

14 

Click Refresh twice until 
the pattern has been 
applied. 
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Editing a Single Day Shift   
(Not Editing a Schedule Pattern) 

 
Purpose 
When your workload needs vary, you may need to change employees’ schedules in order to reduce the number 
of exceptions that might appear on an employee’s timecard. 

 
Example 
You scheduled an employee to work eight hours on Saturday. You now only need the employee for four hours, so 
you edit the employee’s shift for Saturday to reflect the new shift times. You will use the Quick Actions to delete 
the 8-hour shift and insert the 4-hour shift. This example will be completed in Gantt view. 

 
Steps 

1 In the Schedules widget,  

a) right click on the DAY 
in which you would 
like to change the 
START and/or END 
time. 

b) Select EDIT 

 

2  
Edit Shift should appear.  
Next you will type in the 
time (Start/End) 
 
 
 
 
 
 

 

3  

 

4 

 
 

 
9  

Click Save. 
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Deleting a Shift 
Purpose 
Because staffing needs can change, an employee that is scheduled to work a shift may no longer be needed. When 
this happens, you need to delete the shift from the employee’s schedule to prevent the application from flagging the 
employee as absent without an excuse. 

 
Example 
An employee is currently scheduled to work on Friday and is no longer needed. You remove the shift from his 
schedule on Friday to avoid an unexcused absence. Use the Quick Actions to perform the delete. This example 
will use the Gantt view. 

 

Steps 

1 In the Schedule widget, click Quick 
Actions to open the menu. 

 

2  
Click Delete. 
This will turn on the function. 

 

3 Find the shift you want to delete and 
click the cell to delete the shift. 

 

Note: The cursor has changed to a 
crosshair and there are instructions 
at the top of the schedule window to 
help you with the steps. 

 

4  
Click Delete again to turn off the 
function. 
 
Note: Remember to turn off the 
Quick Action function or it will still 
be functional and could cause 
unintended edits. 

 

5  
Click Save. 
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Scheduling a Transfer for a Full Shift - (Grant Employees) 
 

Purpose 
Each employee is assigned a primary labor account and default work rule. During the normal workday, all worked 
and non-worked hours are charged to this assigned labor account. Occasionally, you may need to transfer the 
employee to another labor account or work rule. You need to record the transfer in the application so that the right 
labor account is charged, and the right work rule is applied. You or the employee can record the transfer at a clock 
or directly in the schedule or timecard. 

 
Example 
On Wednesday of the next schedule period, you need an employee to work his entire shift assigned to a specific 
grant. Schedule the employee to work in the grant 8:00 A.M. to 5:00 P.M. on Wednesday of the next schedule 
period. 

 
Steps 

1 In the Schedules widget, select the 
specific time period from the Time Period 
drop-down list.  

2 Locate the employee’s row and right-click 
the cell in that row and under the date 
where you want to add a shift that 
requires a transfer. Click Edit. 

 
   
 

3 In the Edit Shift window, confirm that the correct date appears in the Start Date field. 

4 From the Type drop-down list, select the Transfer shift type. 

5 In the Start Time field, enter the time the shift starts and press Tab. 

6 In the End Time field, enter the time the shift ends and press Tab. 

7 Confirm that the date in the End Date field is correct. If the shift crosses a day divide, you need to change 
the shift’s end date to the following day. 
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 8 
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9a  
To transfer hours to another 
labor account, click the drop-
down list in the Labor Level 
column and select Search. 
Complete the fields in the 
Transfer window. 

 

9b To transfer hours to another 
work rule, select the work rule 
drop-down list from the Job 
Transfer, Labor Level 
Transfer or Work Rule column. 

 
10 Click Apply. 

 

11 Click Save. 

 

12 Note: Hovering over the shift 
will display a pop-up window 
showing the transfer details. 
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Adding Shifts with (Partial Day) Transfers 
Purpose 
Each employee is assigned a primary labor account and default work rule. During the normal workday, all 
worked and non-worked hours are charged to this assigned labor account. Occasionally, you may need to 
transfer an employee to another labor account or work rule for part of his or her shift. You need to note the 
transfer in the application so that the right labor account is charged, and the right work rule is applied. You 
or the employee can note the transfer at a clock or directly in the schedule or timecard. 

 
Example 
Schedule an employee to work part of her shift, 1:00 P.M. to 5:00 P.M. in a specific grant on Monday. 

Steps 

1  
In the Schedules widget, 
select the specific time period 
from the Time Period drop-
down list. 

 

2  
Next, locate the employee’s 
row and right-click the cell in 
that row.  
 
Add the date where you want 
to add a shift that requires a 
transfer. Click Edit. 

 

3 In the Edit Shift window, for the hours the employee is scheduled to work before the transfer, fill 
in the Start Time and the End Time fields. 

4 Click the plus icon (+) to add a new row. 

5 In the new row, in the Type drop-down list, select the Transfer shift type. 

6 In the Start Time field, confirm the time the shift transfer begins and press Tab. 

In the End Time field, enter the time the shift transfer ends and press Tab. 

Confirm that the date in the End Date field is correct. If the shift crosses the day divide, you need 
to change the shift’s end date to the following day. 

7 Select the type of transfer you are performing: Labor Level or Work Rule. 

8 Select Apply  
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9  
To transfer hours to another 
labor account, click the drop-
down list in the Labor Level 
column and select Search. 
Complete the fields in the 
Transfer window. 

 

10  
To transfer hours to another 
work rule, select the work 
rule drop-down list from the 
Work Rule column. 

 

11  
Click Apply. 

 

12  
Click Save. 

 

13  
Note: Hovering over the shift 
will display a pop-up window 
showing the partial transfer 
details. 
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Adding a Paycode to the Schedule 
 
Purpose 
Non-worked hours include sick time and vacation. You should schedule your employees’ non-worked time when 
you know about it in advance. 

 
Accrual balances 
Before you schedule non-worked time, confirm that the employee has accrued enough hours. The Accruals 
option on the Schedule Editor View menu displays the Accruals Reporting Period data with the employee’s 
current and projected accrued time. The balances are accurate as of the last date in the date range. 

 
 

 
 
 

Steps 

1 In the Schedules widget, right-click 
the employee with whom you want 
to view accruals.  

Click View Accruals. 
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Example 
An employee is going to be out on Jury Duty on Monday of the next schedule period. You schedule eight 
hours of Jury Duty to avoid an unexcused absence. Use the Quick Actions and the Gantt view. 

 
Steps 

1 In the Schedules widget, open 
the Quick Actions menu. 

 

2 
Click Pay Code to turn on 
the function. 

 
3  

Select the pay code you want 
to assign from the drop-down 
list. 
 
Tip: You can start entering 
the name of the pay code in 
the search field to quickly find 
what you’re looking for.  

 

4 Find the shift where you want to 
add the pay code and click the 
cell.  

Note: The cursor has changed to 
a crosshair and there are 
instructions at the top of the 
schedule window to help you with 
the steps. 

 

5 
Click Pay Code again to turn off 
the function. 
 
Note: Remember to turn off the 
Quick Action function or it will still 
be functional and could cause 
unintended edits. 

 

6 Click Save. 
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Example 
An employee is having a dental procedure Friday afternoon and needs to take half a day sick time. 
Schedule the employee for four hours of sick time for Friday to avoid an incorrect exception. 

 
Steps 

1 In the Schedules widget, find the 
shift of the employee whose shift 
you want to a pay code. 

 
2 

Right-click the shift and 
select Add Pay Code. 
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Steps 

3 In the Effective Date field, confirm that the correct date is selected. 

4 From the Pay Code drop-down list, select the pay code. 

5 In the Amount field, delete the default Half sched day and replace it with the amount of hours 
(HH:hh). 

6 
(Optional) If the non-worked hours replace an existing shift, select the Override Shift check box and 
do ONE of the following: 

1. To override the entire shift, select Whole Shift. 
2. To override part of the employee’s scheduled shift, select Partial Shift. 

  

In the Start Time field, enter the effective time for the non-worked hours. If the employee already 
has a schedule, the shift start time is the default. 

In the Repeat for (D) field, enter the number of consecutive days. For Example, if the employee has 
requested five consecutive days of vacation, enter 5. 

7 Click Apply and then click Save. 
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Approving Time-Off Requests – Default Request Manager 
 

Purpose 
Employees can submit time-off requests using the Request Time Off button located in the Employee 
Calendar widget. This feature provides a consistent, easily accessible way for employees to request or 
cancel time off, as well as a quick way for timekeepers/supervisors to evaluate and respond to them. 

Steps 

1 
Click the Request Manager 
Alert and select a request type 
to open the Default Request 
Manager widget. 

The number on the alert 
indicates the number of requests 
that are pending. 

The Requests list shows the 
number of requests for each type 
of request. 

  
 

   

2 
Right-click the shift and 
select Add Pay Code. 

 

 
  



 

34  

 

 
 

 

 

 

 

 

 

 

  

 

 

 

 

 
 

 

Steps 

1  
) You can modify the requests in the grid. Above the columns: 

A. Select a time period, location, request type, and status 
B. To view detailed information: 

a. Double-click a request 
b. Select a request, and then click Details or view the information in the Details tab. 

2  
Reveal the bottom section tabs to view COH Accruals Add On section. 
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Reviewing and Editing Time and Attendance Data 
Reviewing Employee Data Using a Genie 

 
Purpose 
UKG Genies present customized views of employee information in a summarized, easy-to-read format so 
that you can quickly analyze and respond to time, labor, scheduling, and attendance needs. 

 
Example 
You want to look for all employees who have unexcused absences in the previous pay period. Use the 
Reconcile Timecard Genie to perform this task. 

 

Steps 

1 In the QuickFind Genie, click 
the drop-down list and select 
Reconcile Timecard genie. 

 
2 

Select the specific time 
period from the Time 
Period drop-down list. 

 

3 
To sort, hover over the 
column and click the arrow 
that appears. From the 
drop-down list select how 
you want to sort. 
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Exporting Genie Data 
Purpose 
UKG Genies display critical information in an easy-to-read format. You can export this information to other 
applications, such as Microsoft Excel, where you can reformat the data for your business needs. For Example, you 
can save labor information in the Reconcile Timecard Genie with an Excel file extension and then open it with 
Microsoft Excel to summarize the data in each column. You can also export the data to a CSV (Comma Separated 
Value) file to make it available to other applications such as Lotus 1-2-3. 
 
Example 
On a regular basis, you export timecard data to Microsoft Excel to perform further data analysis. 

 

 
 

Steps 

1 
Access a Genie, such as the Reconcile Timecard Genie. 

2 Click Share. 
3  

Choose the export option: Print, Export to Excel or Export to CSV. 
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Generating Reports 
Purpose 
You can generate reports on a daily, weekly, pay period basis, or any time you need information to 
accomplish your business tasks. 

 
Example 
For auditing and validation purposes, you want to review all timecard data for employees for the previous pay 
period. Generate a Time Detail report to review this information. 

 

Steps 

1 In the Related Items pane, 
select All Quick Links. 

 
2 

Click General > Reports. 
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Steps 
 
 

3 

 
On the Select Report tab, click the plus (+) to display a category’s contents. Click a report 
name and review its description to ensure that the report returns the data you need. 

 
 

4 
 
 

 
If you selected employees in a Genie, verify that Previously Selected Employee(s) appears in 
the Show field. Or, select a different set of employees from the Show drop-down list. 

Select the specific time period from the Time Period drop-down list. 

 
5 

 
1. To generate a report, click Run Report. 
2. To generate a report and automatically e-mail it to recipients, click E-mail. Fill in the 

Recipients field in the E-mail dialog box and click OK. Then click the Check Run Status tab. 
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Steps 

 

6 
Review information in the Status column. 

Click Refresh Status several times until Complete or Failed appears in the Status column. 

7  
1. To view a report, click a report name to highlight it and do any of the following: 

a. To use menu options, click View Report. 
b. To use mouse options, double-click the report name. 

c. To print the report to a local printer, select File > Print and then select a printer from 
the list. 

d. To send a report in an e-mail message, select File > Send > Page by E-mail and 
complete the e-mail message contained in your default e-mail client. 

 
 

The following is an Example of a Time Detail report: 
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Accessing Employees’ Timecards  
Purpose 
Use Genies to quickly review and monitor employees’ time and attendance data. From a Genie, you can open 
employees’ timecards so that you can make any adjustments prior to payroll processing. 

Example 
In reviewing the Reconcile Timecard Genie, you notice that several employees have time and attendance 
exceptions. You will open the timecards of each of these employees to review and adjust the data. 

 

Steps 

1 In the QuickFind Genie, click 
the drop-down list and select 
Reconcile Timecard genie. 

 
2 

Select the specific time 
period from the Time 
Period drop-down list. 

 

3 
To sort, hover over the 
column and click the arrow 
that appears. From the 
drop-down list select how 
you want to sort. 
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4 
Select the name of the 
employee(s) whose timecards 
you want to review. Click Go To 
menu and select Timecards. 

 

5 If you selected more than 
one employee, do one of 
the following: 

• Click the arrow icons 
next to the employee 
name list to move to the 
next or previous 
employee.  

• Select an employee from 
the Name & ID drop-down 
list. 

 

6  

Place your mouse over 
the exception to display 
its description in a pop-
up message. 
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TOT 

Hourly Employee Timecard Overview  
 

 
 
 
 

Timecard Area   Description 

 
 
 
 
 
 

1 - Timecard workspace 

 
Located in the middle of the page beneath the page header, the timecard 
workspace displays the following information: 

 Menu bar that contains selections for performing timekeeping tasks 

 Grid containing dates for the selected time period 
 Time entry totals, including shift, daily, and cumulative amounts 
 Shift Total – Calculated total hours of all shifts worked on the selected day 

(excluding totals for non-shift items such as pay codes). 

 Daily Total – Calculated total hours of the selected day, including pay codes. 

 Cumulative – Cumulative total up to and including the selected day. 

 All – Calculated total hours for the entire visible time period. 
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2 - Timecard tabs 

 

Located at the bottom of the page, the timecard tabs display additional 
information about how UKG tracks employee hours. Three default tabs appear: 

 Totals & Schedules – The first tab at the bottom of the timecard workspace. The 
area on the left displays the timecard totals. The area on the right displays the 
Schedule for the selected time period. 

 Accruals – Displays accrual codes and available balances based on the date 
selected in the timecard workspace. 

 Audits – Lists all time punch or amount corrections made to an employee’s 
timecard and approvals made by timekeepers/supervisors. 

 Note: Additional tabs will appear based on actions you perform. For Example, 
the Approvals & Sign Offs tab appears when you approve an employee’s 
timecard. 
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Visual Indicators 
Visual indicators appear on a timecard when an exception occurs. For Example, an employee might forget to 
clock in or out, which causes a missed punch exception. An employee might clock in early or late, which 
causes a punch exception. 

 

Visual indicator Description 
 

 

An excused absence for the day, such as Vacation, Bereavement, or 
Jury Duty 

 

An unexcused absence for the day 
 

An exception, such as a late or early punch, or a short or long break 

 

Exception has been marked as reviewed 

 
A missed punch 

 

A transaction that was added by the UKG application 

 

 
One or more comments are attached to the punch or amount. 

 

   Shift Transfer 

 

Approved Overtime 
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Adding Missed Punches 
 
Purpose 
An employee might forget to punch in or out. When this happens, a solid red box appears in the missed In or 
Out cell. To add that punch, you click the cell and type the missed time. The application accepts multiple 
formats for entering punches in a timecard. 

 
Example 
An employee notified you that she forgot to punch out on Monday. The employee started her shift at 8:00 
A.M. and ended her shift at 5:00 P.M. From the Reconcile Timecard Genie, access the employee’s timecard 
and add the 5:00 P.M. out punch on the employee’s timecard for Monday. 

 

Steps 

1 In the QuickFind Genie, click 
the drop-down list and select 
Reconcile Timecard genie. 

 

2 
Select the specific time 
period from the Time 
Period drop-down list. 

 

3 
To sort, hover over the 
column and click the arrow 
that appears. From the 
drop-down list select how 
you want to sort. 
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Steps 

4 
Select the name of the 
employee(s) whose timecards 
you want to review. Click Go To 
menu and select Timecards. 

 

5 If you selected more than 
one employee, do one of 
the following: 

• Click the arrow icons 
next to the employee 
name list to move to the 
next or previous 
employee.  

• Select an employee from 
the Name & ID drop-down 
list. 

 

6  

Locate the missing 
punch by looking for the 
red cell in the timecard. 

 

 

7  

Click in the cell and enter 
5:00PM. Tab out of the 
cell. 

 

 

8  

Click Save. 
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Refreshing and Saving Data in Timecards 
 

Purpose 
When you add and modify timecard data, the application displays your edits but does not save them 
automatically. You must tell the application to save the data. Prior to saving your data, you can decide whether 
the edits are what you want. 

 
Example 
You have been editing the timecard of one of your employees when you realize that you entered the wrong 
information. You cancel the edits, edit the correct information and save it. 

 
Canceling edits 
 
Steps 

1  
Perform one or more edits on a 
timecard. Notice the Save icon is 
orange indicating the data is 
unsaved. 
 
To cancel any edits, click the 
Refresh icon.  

2 
Verify that you want to 
proceed with cancelling the 
edits. 

 

 
 
Saving edits 

 

Steps 

1 Perform one or more edits on a timecard. Notice the Save icon is orange indicating unsaved data. 

2 Click Save. 

3 Review the employee’s timecard to ensure that the visual indicators no longer appear, validating that 
your information was saved. 
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Attaching Comments to Punches 
 

Purpose 
Comments are predefined descriptive phrases that you attach to a punch or amount to provide additional, 
useful information about that transaction. You can attach as many comments as needed to explain the punch or 
amount. You can also add free-text notes to comments for additional clarification. 

 
Example 
After adding an employee’s missing out punch, you now add a comment to the punch. 

 

Steps 

1 Locate and right-click the cell to 
which you want to add a 
comment. 

 

2 In the Punch Actions window, 
click Comments. 

 

3 In the Comments window, 
select one or more comments 
from the list. 

Tip: Hold the Ctrl key to 
select more than one 
comment. 

 

 

4 Click OK. 

 

5 Click Save. 

 

 
 Business practice 

It is a best practice to include comments when applying edits to an employee’s timecard. 
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Deleting Punches with a Comment  
 

Purpose 
As a rule, you should not delete punches from timecards because they represent actual times that 
employees started and stopped working. However, there are some exceptions to this rule. For Example, an 
employee might punch twice when starting or ending a shift. When this occurs, you will want to delete the extra 
punch. The Audits tab provides a record of all timecard edits, including any punches that you delete. 

 
Example 
An employee could not remember if he punched out at the end of his shift. He punched out a second time to 
ensure that he recorded his end-of-shift time. While reviewing the employee’s timecard, you notice that two out 
punches appear for the employee’s end of shift. You want to delete the employee’s second out punch, but first 
you need to add a comment to that punch. The comment will appear in the audit trail. From the Reconcile 
Timecard Genie, access the employee’s timecard, then add a comment to and delete the duplicate out punch. 

 

Steps 

1  
In the timecard, click the cell 
that contains the punch you 
want to delete. 

 

 

2 Right-click the cell and select 
Comments. 

 

3  
Select one or more 
comments from the list. 

Tip: Hold the Ctrl key to 
select more than one 
comment. 
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Steps 

4  

Click OK. 

 

5  
Verify that the comment 
icon shows in the cell. 

 

6  
Select the cell and press 
Delete. 
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Adding Pay Code Amounts to Timecards  
 

Purpose 
Pay codes keep track of the type of worked and non-worked time that is entered in the timecard.  

Examples of pay codes include: Holiday, Overtime, Sick, and Vacation. 

It is important that hours are tracked to the correct pay code so that the employee is paid correctly. There are 
times when you might have to edit an employee’s timecard and use a pay code to track his or her worked or 
non-worked time; for Example, when the employee calls in sick. 

 
Acceptable formats for entering pay code amounts 
 

 

Acceptable format Example Interpretation by UKG 
 
 

Leading zeros (optional) 

07 7:00 hours 
 

08:30 

 

8:30 hours 

 
 
 
 
 

Colon 

 
 
 
 
 

7:30 

 
7:30 hours 

 

Note: If you enter an amount without a 
colon UKG interprets your entry as is, 
which may be a much larger amount than 
you meant. For Example, if you enter 730 
(without the colon), UKG interprets that as 
730 hours. 

 
Decimal 

 
8.5 

 
8:30 hours 

 
Full Schedule Day/  
Half Schedule Day 

 
full schedule day/ half schedule 
day in the Amount field 

 

Employees receive hours based on their 
schedule assignments for that day 
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Example 
An employee called in sick on Tuesday. His timecard was not updated to reflect this. From the Reconcile 
Timecard Genie, access the employee’s timecard. Add eight hours of sick time to his timecard. 

 
Steps 

1 From the Reconcile Timecard 
Genie, select the specific time 
period from the Time Period 
drop- down list. 

 

3 Sort the Unexcused Absence 
column. 

 

4 Select one or more employees 
whose timecards you want to 
edit and click the Timecard 
quick link. 

 

5 Identify the day with the 
unexcused absence. Does the 
day already have punches? 

No - On the row of the date 
where you want to enter the pay 
code amount, select the pay 
code from the Pay Code drop- 
down list. 

Yes - On the row of the date 
where you want to enter pay 
code amount, click the Insert 
Row icon. 
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Steps 

6  
Click the Pay Code cell and 
select the pay code from the 
drop-down list.  

 

 
7 Click the Amount cell next to 

the pay code you selected. 
Enter the number of hours, 
using an acceptable format, or 
select one of the scheduling 
amount options. 

 

8 Click Save. 

 
 
 

Note 
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Paying Employees for Meals  
 

Purpose 
Work rules define basic time and labor conditions, such as how breaks and meal deductions occur during shifts. 
For Example, a work rule might stipulate that an employee must work a minimum of five hours before a meal 
deduction of 30 minutes is applied automatically to her time. This automatic deduction is reflected in the shift 
hours total. There may be times when an employee works through his or her meal, so you will need to cancel 
the automatic meal deduction to add the time worked to the timecard. 

 
Example 
An employee worked through her lunch break on Friday due to a heavy workload. From the Reconcile 
Timecard Genie, access the employee’s timecard and cancel her meal deduction for Friday. 

 

Steps 

1  
From the QuickFind Genie, 
select the time period in the 
Time Period drop-down list. 
 
Select the employee and 
double-click the employee’s 
name to open his/her timecard.  

 

 

2 Right-click the Out punch cell 
on the date you want to cancel 
the deduction.  

3 Click Edit. 
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Steps 

4 In the Cancel Deduction drop-
down list, select the deduction 
you want to cancel from the 
Cancel Deduction drop-down 
list. 
(Be sure to select the 
appropriate minute deduction 
that ends with “QTR”) 

 

5 Click OK. 

 

6 Click Save. 

 

 

 

 
 

     Tip 
      You can restore a meal deduction cancellation by performing the same steps and selecting 
       <None> from the Cancel Deduction drop-down list. 

    Caution 

 
 

Note 
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Marking and Unmarking Exceptions as Reviewed  
 

Purpose 
Once you have reviewed an exception and resolved it to your satisfaction, you can mark the exception as 
having already been reviewed. The exception will remain visible in the timecard and in genies but will no longer 
appear in exception reports or queries. Once the exception is marked as reviewed, a green icon will appear in 
the cell containing the exception. Additionally, at any time you can choose to unmark an exception as 
reviewed. 

 
 

Example 
On Wednesday an employee arrived late to work because he had car problems. You add a comment to the 
employee’s late in punch as a reminder of why the employee did not work his entire shift. Then you mark the 
exception as reviewed so that you do not re-check it again at a later date. 

 
 

Steps 

1  
In the timecard, right-click the 
cell containing the exception. 

 

 

2  
In the Punch Actions menu, 
click Comments. 

 

Steps 
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3  
 

In the Comment window, 
select the appropriate 
comment. 

Click OK. 

 

4 Right-click the cell again. 

In the Punch Actions window, 
click Marked As Reviewed. 

 

5 Verify that the green icon and 
the comment icon are 
displayed. 

 

6 Click Save. 
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Transferring Hours for Entire Shifts  
 

Purpose 
Each employee is assigned a primary labor account and default work rule. During the normal workday, all 
worked and non-worked hours are charged to this assigned labor account. Occasionally, you may need to 
transfer the employee to another labor account or work rule. You need to record the transfer in the application 
so that the right labor account is charged, and the right work rule is applied. You or the employee can record 
the transfer at a terminal or directly in the schedule or timecard. 

 
Example 
On Monday an employee worked eight hours in a specific DAC, which is not her primary assignment. Access 
the employee’s timecard and transfer the eight hours of worked time for Monday of the previous pay period to 
the applicable DAC. 

 

Steps 

1  
In the Reconcile Timecard 
Genie, select the time period 
from the Time Period drop-
down list.  
Double-click the employee’s 
name you want to transfer. 

 

 

2  
Click the Transfer cell in the 
row for the for the date you 
want to record the transfer. 

 

Steps 
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3  
If the labor account or work 
rule does not appear in the 
Transfer list, select Search. 

 

4a  
To transfer hours to another 
labor account, click a labor 
level option and select the 
labor level from the Available 
Entries list. 

Click Apply. 

 

4b  
To transfer hours to another 
work rule, select the work rule 
from the Work Rule drop- 
down list. 
 
Click Apply. 

 

5   
Click Save. 

 
 



 

60  

Transferring Hours for Parts of Shifts  
 

Purpose 
Each employee is assigned a primary labor account and default work rule. During the normal workday, all 
worked and non-worked hours are charged to this assigned labor account. Occasionally, you may need to 
transfer the employee to another labor account or work rule for a portion of his or her shift. You need to record 
the transfer in the application so that the right labor account is charged, and the right work rule is applied. You 
or the employee can record the transfer at a terminal or directly in the schedule or timecard. 

 
Example 
On Tuesday an employee worked in a DAC, which is his primary labor account assignment, from 8:00 
A.M. to 11:00 A.M. He then worked in another DAC from 11:00 A.M. to 5:00 P.M. Access the employee’s 
timecard and transfer his worked hours for Tuesday of the previous pay period from 11:00 A.M. to 5:00 
P.M. to the applicable DAC. 

 
Steps 

1  
In the Reconcile Timecard 
Genie, select the time period 
from the Time Period drop-
down list.  
Double-click the employee’s 
name you want to transfer. 

 

 

2  
Locate the day you want to 
add a partial transfer. Click the 
plus icon (+) to add a new 
row.  

3  
In the new row In punch, enter 
the time the transfer begins. 

 

4  
Click the Transfer cell in the 
new row and select the 
transfer. 

If the labor account or work 
rule does not appear in the 
Transfer list, select Search. 

 

5   
Click Save. 

 
 
 



 

61  

Historical Edits  
Purpose 
Once a pay period has been closed, only Central Payroll can make changes to an employee’s timecard. 

 

Finalizing Timecards 
 
 

Reviewing Time Data Using the Pay Period Close Genie  
 

Purpose 
The Pay Period Close Genie helps you to identify timecard discrepancies at the end of a pay period so that you 
can perform any final edits. You must correct all exceptions before time data is signed off by Payroll and 
timecards are locked. Otherwise, employees may not get paid correctly for that pay period. 
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Approving Individual Timecards  
 

Purpose 
After you finish editing your employees' timecards, you need to approve them to indicate to payroll that they are 
ready for processing. You can approve timecards on a Genie or on a timecard itself. After you approve a timecard, 
the employee cannot make any edits to it unless you remove your approval. 

Example 
You have reviewed the employee’s time data and performed all necessary edits. You approve the employee’s 
time for the previous pay period on her timecard. 

 

Steps 

1  
From the Pay Period Close 
Genie, select Previous Pay 
Period from the Time Period 
drop-down list.  

 

 

2  
Double-click the employee’s 
name whose timecard you 
want to approve. 

 

3  
Click Approve Timecard > 
Approve Timecard. 
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Steps 

4  
A message will appear 
confirming the approval and 
the timecard will change 
color. 

 

5   
To remove the approval, click 
Approve Timecard > 
Remove Timecard 
Approval. 

 

6  
In the Pay Period Close 
Genie, there will be a 1 in the 
Manager Approval column 
indicating the employee’s 
timecard has been approved. 
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Approving Multiple Timecards  
 

Purpose 
Once you have reviewed and updated your employees’ timecards, you can approve them all at once, rather 
than approving them individually. When you approve multiple timecards at once, use the Group Edit Results 
page to confirm that all of them are approved. If one or more of the timecards are not approved, the Details link 
on the Group Edit Results page identifies whose timecard was not approved and why. 

 
Example 
You have reviewed and completed final edits to your employees’ timecards. You will approve them all at once. 
 

Steps 

1  
From the Pay Period Close 
Genie, select Previous Pay 
Period from the Time Period 
drop-down list.  

 

 

2  
Select the employees you 
whose timecards you want to 
approve. 
 
Note: If you want to approve 
everyone’s timecard, click 
Select All Rows. 

 

3  
Click Approve Timecard > 
Approve Timecard. 

 

4  
Verify you want to approve all 
timecards selected. 
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Steps 

5  
To verify that the timecards 
have been approved, click the 
Refresh icon.  

6  
There will be a 1 in the 
Manager Approval column 
indicating the employee’s 
timecard has been approved. 

 

5   
To remove the approval, click 
Approve Timecard > 
Remove Timecard 
Approval. 

 
 
 

 
Business practice 
After you approve one or more employees’ timecards, they are no longer editable. If the 
need arises and you have the appropriate permissions, you can remove your approval. 
After you remove your approval, you can make the necessary timecard edits and then re-
approve the timecards. 
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Performing Additional Timekeeper/Supervisor Tasks 
Using the Work & Absence Summary Calendar  

 
Purpose 
You can use the Work & Absence Summary calendar to identify trends in worked and time-off events for 
employees. The calendar-like display makes it easy for you to see whether an employee has a pattern of taking 
time off or of arriving late on a specific day. You can see trend information such as the following: 

• Number of days the employee has arrived late to work 

• Number of Mondays the employee has called in sick 

• Number of weekends the employee is scheduled and has worked 
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To navigate to the Work & Absence Summary Calendar. 

Ste 
Steps 

1  
From the Related Items pane, 
select All Quick Links.  

 

2  
Click Self Service > Work & 
Absence Summary. 
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Requesting Backup Coverage  
 

Purpose 
You can temporarily delegate your timekeeper/supervisor authority to perform your timekeeping and scheduling 
tasks to other timekeepers/supervisors. The other timekeepers/supervisors can perform your tasks using their 
own user names and passwords. For Example, they can modify schedule shifts for absent employees, or 
review and approve timecards. This allows the business process to keep moving, even when you are not there. 
All edits they perform are recorded and assigned to their names for audit Purposes. You can only delegate to 
one (1) supervisor at a time. 

 
Example 
You are going out on vacation. You send a delegation request to another timekeeper/supervisor so that you 
can temporarily assign your timekeeping tasks to her. This will ensure that your employees’ timecards are 
processed for payroll on a timely basis. 

 

Steps 

1  
From the Related Items pane, 
select All Quick Links.  

 

 
2  

Click Actions. 
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Steps 

3  
Click Actions widget, click 
Delegate to Another Manager. 

 

4 In the pop-up window, complete 
the New Delegation section. 
 
Click Save & Close. 

 

5  
The application sends the 
delegation request to another 
timekeeper’s/supervisor’s Inbox. 
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Canceling Delegation  
 

Purpose 
Once the end date of delegation occurs, the application automatically removes the rights of the other 
timekeeper/supervisor to your tasks. You can manually end the delegation earlier. 

 
Example 
You had delegated your timekeeper/supervisor tasks to another timekeeper/supervisor through the end of next 
week so that you could take vacation time. You have since changed your plans and will not be taking vacation 
after all. Now you need to cancel the delegation. 

 

Steps 

1  
From the Related Items pane, 
select All Quick Links.  
 
Click Actions. 

 

 
2  

Click Actions widget, click 
Delegate to Another Manager. 

 

3 In the Action window, select 
Remove Existing Delegation. 
 
Click Next. 
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4  
Select the existing delegation 
and click Delete. 

 

5 Click Close. 
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Delegation 
Accepting or Declining Backup Coverage Requests  

 
Purpose 
When another timekeeper/supervisor sends you a request to cover his or her timekeeping and scheduling tasks, 
the application automatically places a task in your Inbox. The delegation request specifies the start and end dates 
and the role you will assume. You can accept or decline the request in the application. 

 
 

 

 
  

 
Steps 

1  
 Click on the Globe (Related Item Pane Area) located on the right-hand side. 
 Next, click All Quick Links 
 Select General >click on Inbox 

 
 

 

2 From the Tasks tab, select the delegation request and click Edit. 

 

3   In the Action section, accept or decline the delegation request. 

4  
(Optional) Enter a message to the requesting timekeeper/supervisor in the Comment field. 
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Delegation 
Switching to Delegated Roles  

 
Purpose 
After you accept a delegation request, the application automatically provides you with access to the tasks 
defined in the role profile on the specified start date. A Switch Role link appears as a quick link so that you do 
not have to log on as the timekeeper/supervisor who delegated the tasks to you. The link identifies which role 
you currently are working. 

 
Example 
Another timekeeper/supervisor delegated his tasks to you this week and you are ready to perform his 
timekeeper/supervisor tasks. You do not need to log off as yourself and log on as the other manager because 
you can switch roles while logged on with your own user name and password. 

 

Steps 

1  
Click the Switch Role arrow 
next to your name. 
Note: If you do not see the 
Switch Roles link, log off and 
then log on again using your 
own username and password. 

Select the 
timekeeper/supervisor 
whose tasks you will perform 
as his or her delegate. 

 

 

2  
You’ll know you have switched 
because of the message 
displayed under your name. 

 

3 
To switch back, click the 
Switch Role arrow and choose 
Myself. 

 

 

 
 

Note 
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